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LAPORAN AKHIR PENGABDIAN MANDIRI 

RINGKASAN 

Praktik Baik Pengembangan Teaching Factory SMK Negeri 2 Bengkulu Tengah 

Praktik Baik Pengembangan Teaching Factory SMK Negeri 2 Bengkulu Tengah disampaikan 

oleh Narasumber Dosen Program Studi Pendidikan Vokasional Teknik Elektronika yaitu 

Pramudita Budiastuti, S.Pd., M.Pd. yang diikuti oleh 10 peserta yang terdiri dari pengelola 

Teaching Factory (TEFA) di sekolah. Lokasi pengabdian dilaksanakan di SMK Negeri 2 

Bengkulu Tengah (Jl. Sri Katon Blok V, Seikaton, Kec. Pondok Kelapa, Kab. Bengkulu 

Tengan Prov. Bengkulu). Pengabdian dilaksanakan pada hari/tanggal Kamis-Jumat, 28-29 

November 2024, pukul 09.00-selesai. PKM Praktik Baik Pengembangan Teaching Factory 

berupa pemberian materi yaitu contoh pengelolaan TEFA di SMK Negeri 1 Buduran dan SMK 

Negeri 5 Surabaya. Praktik baik berupa: 1) Perencanaan TEFA, 2) Pelaksanaan TEFA, 3) 

Capaian Pembelajaran TEFA, 4) Modul Ajar TEFA, 5) Pengelolaan SDM TEFA, 6) 

Pengelolaan Sarana TEFA, dan 7) Promosi Produk TEFA. Manfaat PKM Praktik Baik 

Pengembangan Teaching Factory yaitu 1) Memberikan panduan langkah-langkah yang 

terbukti efektif, sehingga dapat mengurangi waktu yang dihabiskan untuk coba-coba, 2) 

Meningkatkan kualitas hasil kerja karena metode atau praktik tersebut sudah teruji 

keberhasilannya, 3) Membantu memitigasi risiko dengan mengikuti standar yang telah 

ditetapkan, 4) Materi praktik baik menyediakan referensi yang jelas bagi pemula untuk belajar 

dengan lebih cepat dan terarah, dan 5) Memberikan inspirasi untuk mengadaptasi metode 

dalam konteks yang berbeda. Hasil PKM adalah adanya peningkatan pengetahuan dan 

keterampilan pengelola TEFA di sekolah dalam pengembangan teaching factory di SMK 

Negeri 2 Bengkulu Tengah. Peran mitra yaitu berkontribusi dalam segi fasilitas, kehadiran 

peserta, ketepatan waktu pelaksanaan PKM, dan tenaga. Luaran pengabdian yaitu berupa video 

kegiatan, video pkm telah terunggah di channel youtube LPPM, Link Youtube: 

https://www.youtube.com/watch?v=96fFWB02vxU  

Industri; Pengembangan; Praktik Baik; SMK; Teaching Factory; 

Tabel Keberdayaan Mitra Kegiatan PkM 

No Jenis Mitra Jenis Keberdayaan 
Cek List 

1 Mitra Non 

Produktif 

Ekonomi 

Pengetahuannya meningkat ✓ 

Keterampilannya meningkat ✓ 

Kesehatannya meningkat   

Pendapatannya meningkat   

Ringkasan memuat uraian secara cermat dan singkat kegiatan yang telah dilaksanakan 

meliputi 5W 1H (Apa, Siapa, Dimana, Kapan, Mengapa, dan Bagaimana), keterlibatan 

mahasiswa (jika ada), peran mitra, dan capaian luaran (jika ada), ditulis dengan jarak satu 

spasi. 

 

No Jenis Mitra Jenis Keberdayaan 
Cek List 

1 Mitra Non 

Produktif 

Ekonomi 

Pengetahuannya meningkat ✓ 

Keterampilannya meningkat ✓ 

Kesehatannya meningkat   

Pendapatannya meningkat   

Pelayanannya  meningkat   

2 Mitra Produktif 

Ekonomi 

Pengetahuannya meningkat   

Keterampilannya meningkat   

Kualitas produknya meningkat   

Jumlah produknya meningkat   

Jenis produknya meningkat   

Kapasitas produksi meningkat   

Jumlah aset meningkat   

Jumlah omsetnya meningkat   

Kemampuan manajemennya   

Keuntungannya meningkat   

Produk tersertifikasi   

Produk terstandarisasi   

Unit usaha berbadan hukum   

Jumlah wirausaha baru mandiri 

meningkat 

  

 Ringkasan memuat uraian secara cermat dan singkat kegiatan yang telah dilaksanakan 

meliputi 5W 1H (Apa, Siapa, Dimana, Kapan, Mengapa, dan Bagaimana), keterlibatan 

mahasiswa (jika ada), peran mitra, dan capaian luaran (jika ada), ditulis dengan jarak satu 

spasi. 

Kata kunci maksimal 5 kata kunci. Gunakan tanda baca titik koma (;) sebagai pemisah dan 

ditulis sesuai urutan abjad. 

 

 

 

 

Kata kunci maksimal 5 kata kunci. Gunakan tanda baca titik koma (;) sebagai pemisah dan 

ditulis sesuai urutan abjad. 

 

 

 

https://www.youtube.com/watch?v=96fFWB02vxU


No Jenis Mitra Jenis Keberdayaan 
Cek List 

Pelayanannya  meningkat   

2 Mitra Produktif 

Ekonomi 

Pengetahuannya meningkat   

Keterampilannya meningkat   

Kualitas produknya meningkat   

Jumlah produknya meningkat   

Jenis produknya meningkat   

Kapasitas produksi meningkat   

Jumlah aset meningkat   

Jumlah omsetnya meningkat   

Kemampuan manajemennya   

Keuntungannya meningkat   

Produk tersertifikasi   

Produk terstandarisasi   

Unit usaha berbadan hukum   

Jumlah wirausaha baru mandiri 

meningkat 

  

 
LAMPIRAN 
 

1. Materi/Bahan Pelatihan/Penyuluhan; 

2. Surat Permohonan dari Mitra (wajib); 

3. Surat ucapan terima kasih/ sertifikat narasumber (wajib); 

4. Surat Tugas Dekan atau Kepala LPPM (wajib); 

5. Daftar hadir peserta; 

6. Dokumentasi Peserta; 

7. Luaran PkM. 

Keterangan : 

*) Wajib dilampirkan 

 

 

 



Luaran Video di youtube LPPM 

 

 
 

Link Youtube: https://www.youtube.com/watch?v=96fFWB02vxU  
 

https://www.youtube.com/watch?v=96fFWB02vxU
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PRESENTAT ION 2024

Profil SMK Negeri 
5 Surabaya
Perintis Sekolah Teknologi Menengah Negeri 

Pembangunan Surabaya, memiliki 9 Kompetensi 

Keahlian dengan Tenaga Pendidik berkompeten 

dan fasilitas memadai

SMK NEGERI 5 
SURABAYA

Jalan Prof. Dr. Moestopo No. 167 - 169, Surabaya, 

Jawa Timur, Indonesia

47.565 m² = 4,7 Hektar

3.063 Siswa/i

Sukses, Mandiri, dan Bermartabat



PRESENTAT ION 2024

TEFA (Teaching 
Factory)

adalah model pendidikan yang mengintegrasikan proses 

pembelajaran dengan produksi nyata di lingkungan sekolah. 

Tujuan utamanya adalah memberikan pengalaman praktis 

kepada siswa dengan cara melibatkan mereka langsung dalam 

kegiatan produksi dan bisnis, mirip dengan kondisi yang ada di 

industri. Dengan demikian, siswa tidak hanya belajar teori, 

tetapi juga menerapkan pengetahuan dan keterampilan 

mereka dalam situasi nyata, sehingga lebih siap untuk 

memasuki dunia kerja.

SMK NEGERI 5 
SURABAYA



SMK NEGERI 5 
SURABAYA

Menyiapkan fasilitas 
yang mendukung 

kegiatan produksi, 
seperti bengkel, 

laboratorium, dan 
peralatan produksi.

Fasilitas dan 
Infrastruktur 

Identifikasi kebutuhan 
masyarakat dan tren 
pasar bersama siswa 
untuk menentukan 

produk yang sesuai dan 
dapat dijalankan dengan 

baik oleh siswa.

Analisis Kebutuhan Kerja Sama 
dengan Industri 

Membangun kemitraan 
dengan perusahaan 
untuk mendapatkan 
dukungan, termasuk 
fasilitas, bahan, dan 

pelatihan.

Memberikan pelatihan 
kepada guru dan siswa 

yang terlibat agar 
mampu melaksanakan 

pembelajaran TEFA 
berdasarkan standar 

industri dan teknologi 
terkini.

Pelatihan

Perencanaan 
Teaching Factory 

PRESENTAT ION 2024

Penyesuaian 
Kurikulum antara 

pendidikan 
dengan industri 
Menyusun kurikulum 
yang berbasis pada 
praktik industri dan 

kompetensi yang 
diperlukan oleh siswa.



SMK NEGERI 5 
SURABAYA

Siswa didorong untuk 
berinovasi dalam 
mengembangkan 

produk yang sesuai 
dengan kebutuhan 

pasar.

Pengembangan 
Produk

Memanfaatkan masukan 
dan bimbingan dari mitra 

industri untuk 
peningkatan kualitas 

produk dan 
pembelajaran.

Kolaborasi dgn 
Industri

Monitoring dan 
Evaluasi

Guru dan siswa 
melakukan 

pengawasan dan 
evaluasi berkala untuk 
memastikan kualitas 
produk dan proses 

pembelajaran.

Siswa terlibat 
langsung dalam 

proses produksi, mulai 
dari perencanaan, 

pembuatan, hingga 
pemasaran produk.

Kegiatan 
Produksi

Pelaksanaan 
Teaching Factory 

PRESENTAT ION 2024

Melibatkan siswa 
dalam kegiatan 
pemasaran dan 

penjualan produk 
untuk mengembangkan 

keterampilan 
kewirausahaan.

Pemasaran & 
Penjualan



SMK NEGERI 5 
SURABAYA 
MENERAPKAN 
PEMBELAJARAN 
TEACHING FACTORY, 
SALAH SATUNYA 
ADALAH PELATIHAN 
KEWIRAUSAHAAN 
YAITU

PRESENTAT ION 2024

STUDENT 
COMPANY / 
Perusahaan siswa 

SMK NEGERI 5 
SURABAYA



Perusahaan 
Siswa

Analisis 
Lab PIK

DPK

AIK

PKK

Maserasi

Grinding

Sizing

Mixing

Pengoperasian Alat 
Industri Kimia

Dehydrator Oven Autoclave 

SMK NEGERI 5 
SURABAYA

Analisa Mikrobiologi 
untuk produk TEFA

TPC E- Coli Yeast & Mold

PRESENTAT ION 2023

Bisnis menyeluruh di 
bidang TKI

Logistik proses 

Budaya Kerja 5R

Isu global, kearifan 
lokal, waste control 

Kegiatan Produksi, 
seperti: Produksi 
massal, membuat 
prototype, proses 

packing, dan 
membuat GMP 

Kewirausahaan, seperti: 
menghitung HPP 

produk, melakukan 
pemasaran, melakukan 
promosi pada sosial 

media



1

2

3

4

Siswa mampu menyusun rencana produksi yang 
mencakup menetapkan jenis dan jumlah produk, 
desain produk, proses kerja pembuatan prototipe, 
dan menghitung biaya produksi.

Siswa mampu membuat produk dengan menyusun 
rencana dan jadwal kerja, menetapkan strategi 
produksi, standar spesifikasi produk, melaksanakan 
produksi, dan pengendalian mutu (quality assurance).

Siswa mampu membuat desain kemasan, 
melaksanakan pengemasan produk, dan membuat 
label.

Siswa mampu menentukan strategi distribusi dan 
memberikan layanan terhadap keluhan pelanggan.

SMK NEGERI 5 
SURABAYA

PRESENTAT ION 2024Impact bagi Capaian 
Pembelajaran 

MAPEL : Produk Kreatif Kewirausahaan 

ELEMENT : Kegiatan Produksi 

Capaian Pembelajaran
Realisasi

• SC membuat lean 
canvas.

• SC menentukan target 
pasar untuk produk.

• SC menentukan HPP 
produk.

• SC menentukan jadwal 
produksi & weekly 
meeting.

• SC melakukan pengujian 
produk.

• SC melakukan pemasaran 
& survey pelanggan



SMK NEGERI 5 
SURABAYA

1

2

3

4

5

Siswa mampu membaca peluang usaha dengan 
mengidentifikasi potensi lingkungan internal dan 
eksternal SMK serta menetapkan jenis usaha.

Siswa mampu menyusun proposal usaha (business plan) 
yang mencakup perencanaan usaha, biaya produksi, 
break even point (BEP), dan return on investment (ROI).

Siswa mampu memasarkan produk dengan menentukan 
segmen pasar, harga produk, dan media pemasaran.

Siswa mampu menerapkan prinsip Hak Atas Kekayaan 
Intelektual (HAKI), menjelaskan konsep HAKI, dan 
mematuhi peraturan tentang HAKI.

Siswa mampu menyusun laporan keuangan berupa 
laporan neraca, laporan laba rugi, laporan perubahan 
modal, dan laporan arus kas.

Impact bagi Capaian 
Pembelajaran 

PRESENTAT ION 2024

MAPEL : Produk Kreatif Kewirausahaan 
ELEMENT : Kewirausahaan Realisasi

• SC menentukan produk yang 
dapat menyelesaikan 
permasalah target pasar.

• SC mampu membuat business 
plan.

• SC mampu menjual saham dan 
mendapat keuntungan besar.

• SC melakukan pengajuan merk 
sebagai HAKI dari SC

• SC membuat financial report 
setiap bulan.



SMK NEGERI 5 
SURABAYA

1

2

3

4

Realisasi

Siswa mampu memahami dan praktik langsung 
dalam Proses Logistic

Siswa mampu memahami dan menerapkan 
mikrobiologi

Siswa mampu memahami dan praktek langsung 
mengenai pekerjaan pada bidang kimia industri 
seperti; Proses Produksi

Siswa mampu memahami profesi dan 
kewirausahaan, serta peluang usaha di bidang 
kimia industri

Impact bagi Capaian 
Pembelajaran 

PRESENTAT ION 2024

MAPEL : Dasar Program Keahlian

• Membuka dropship di SMKN 5 
Surabaya

• Melakukan pengujian mikrobiologi 
pada produk TEFA.

• SC melakukan proses produk.
• Mendirikan perusahaan siswa 
sebagai bentuk realisasi job profile 

dan kewirausahaan 

Capaian Pembelajaran



SMK NEGERI 5 
SURABAYA

Realisasi

1

2

3

Siswa mampu memahami dan praktik langsung 
dalam Proses Industri Kimia

Siswa dapat mengerti dan dapat membuat 
diagram alir proses

siswa mampu mengetahui utilitas yang di perlukan 
dan bagaimana cara menjaga ketersediaan bahan 
baku

Capaian Pembelajaran

Impact bagi Capaian 
Pembelajaran 

PRESENTAT ION 2024

MAPEL : Proses Industri Kimia

• SC melakukan proses industri kimia 
seperti; maserasi, grinding, sizing, 

dan juga mixing 

• SC membuat good manufacturing 
practice (GMP) sebagai upaya 

untuk menjaga ketersediaan bahan 

baku



SMK NEGERI 5 
SURABAYA

PRESENTAT ION 2024

Realisasi

1

2

3

Siswa mampu memahami dan praktik langsung 
dalam mata pelajaran Alat Industri Kimia

Siswa mampu mengoperasikan alat industri kimia

siswa mampu mengetahui bagaimana cara alat 
industri kimia beroperasi 

Capaian Pembelajaran

Impact bagi Capaian 
Pembelajaran 

MAPEL : Alat Industri Kimia

• SC melakukan proses industri 
kimia yang melibatkan alat 

industri kimia seperti; 

dehydrator, oven, autoclave 

sesuai dengan standard industri 



NO ELEMENT Capaian Pembelajaran 
Kerja Sama 
Industri Output yang dihasilkan

1 Proses Logistic
Siswa mampu memahami dan 
praktik langsung dalam Proses 

Logistic
JNE

Siswa mendapatkan 
pengalaman langsung 

mengenai proses logistic

2 Mikrobiologi
Siswa mampu memahami dan 
menerapkan mikrobiologi 

* pengujian eksternal
- Biochem
- Biofarma

Siswa mampu mengujikan 
produk TEFA secara mandiri

3
Bisnis Menyeluruh 
di Bidang Teknik 
Kimia Industri 

Siswa mampu memahami dan 
praktek langsung mengenai 
pekerjaan pada bidang kimia 

industri seperti; Proses Produksi

- KEMENPERIN BPIPI
- UMKM ANYA CRAFT

Siswa mendapatkan 
pengalaman dalam menjalin 
kerjasama, proses produksi, 
pemasaran dan alat industri 

4
Job Profile & 

Technopreneurship 

Siswa mampu memahami profesi 
dan kewirausahaan, serta peluang 
usaha di bidang kimia industri

- PJI
- Zurich Foundation

Terbentuknya Student 
Company yang mengajarkan 
siswa dalam kewirausahaan 

BERBASIS TEFA 
CONTOH MODUL AJAR 

TEKNIK KIMIA INDUSTRI 
Mata Pelajaran: Dasar Program Keahlian 



MATERI

Pemahaman materi 
tentang logistic dan 
industri kimia dengan 
metode blended learning

AKTIF ITAS OUTPUT

• Peserta didik menyimak 
materi tentang logistic

• Membuat rangkuman 
dan sesi diskusi

• Praktek langsung 
mengenai proses 
logistic melalui 
kerjasama dgn JNE

• Peserta didik 
mendapatkan 
pemahaman dan 
pelaksanaan proses 
logistic sesuai dengan 
standard industri 

Proses
Logistic (1) 



MATERI

Pemahaman materi 
tentang dasar 
mikrobiologi untuk 
menganalisa produk yang 
di hasilkan TEFA

AKTIF ITAS OUTPUT

• Peserta didik menyimak 
materi mengenai media 
dan dasar mikrobiologi  

• Praktik langsung 
pengujian mikrobiologi 
pada produk TEFA

• Peserta didik 
mendapatkan 
pemahaman dan praktek 
langsung tentang 
analisa mikrobiologi 
yang dilakukan untuk 
produk produk teaching 
factory 

Dasar
Mikrobiologi (2)



Bisnis Menyeluruh
Kimia Industri (3)

MATERI

Pemahaman materi 
tentang pekerjaan di 
bidang teknik kimia 
industri 

AKTIF ITAS OUTPUT

• Peserta didik menyimak 
materi tentang 
pekerjaan di bidang KI 

• Menerapkan materi 
dengan melakukan 
kerjasama langsung 
dengan industri.

• Peserta didik 
mendapatkan 
pemahaman dan 
pengalaman langsung 
tentang proses 
produksi, dan semua 
pekerjaan di bidang KI

di Bidang



Job Profile &
Technopreneurship (4)

MATERI

Pemahaman materi 
tentang Job Profile dan 
Technopreneurship 

AKTIF ITAS OUTPUT

• Peserta didik menyimak 
materi tentang job 
Profile dan 
Technopreneurship 

• Membuat perusahaan 
siswa yang berbasis 
kewirausahaan 

• Menentukan job setiap 
anggota

• Peserta didik 
mendapatkan 
pemahaman tentang 
proses kewirausahaan, 
dimana terfokus kepada 
job profil dan 
technopreneurship 



PEMBELAJARAN 
KEWIRAUSAHAAN

DI SMK NEGERI 5 SURABAYA

1) TEACHING FACTORY
2) UPJ BLUD
3) KELAS INDUSTRI
4) STUDENT COMPANY
5) TRACER STUDY

SMK NEGERI 5 
SURABAYA

PRESENTAT ION 2024



Menjadi guru adalah sebuah 
pengabdian, jadilah guru 
yang focus mencetak 
generasi cemerlang di 
Indonesia.karena kalau bukan 
kita, siapa lagi?!

SMK NEGERI 5 
SURABAYA

PRESENTAT ION 2024



Thank you

SMK NEGERI 5 
SURABAYA

ABOUT  US PERENCANAAN & 
PELAKSANAAN

MODUL  AJAR  KUNJUNGAN



KEWIRAUSAHAAN 
SEKOLAH MELALUI 
PENGEMBANGAN 
TEACHING FACTORY
Di SMK NEGERI 1 BUDURAN

1

Oleh :  Dra,



Lahir di Tulungagung 17 Agustus 1966

* Kepala SMK Negeri 1 Pagerwojo Tulungagung

* Kepala SMK N 2 Boyolangu Tulungagung

* Kepala SMK N 1 Buduran Sidoarjo

PRESTASI :

1. KS Prestasi Nasional

2. KS Berwawasan Lingkungan Nasional

3. Mendapat Penghargaan Best Practice Sekolah Unggul Nasional

4. MEMILIKI SERTIFIKAT Peningkatan 

Kapabilitas Manajerial Kepala SMK Berbasis 

Industri

5.      MEMILIKI SERTIFIKAT RECOGNISI KEPALA SEKOLAH SEBAGAI GURU 

PENGGERAK

PROFIL NARASUMBER 



SMK  REVITALISASI
2019

SMK COE

2020

SMK PK 

2021

SMK PK 
LANJUTAN

2022



q Sebagai SMK Revitalisasi
q SMK – BLUD
q SMK COE Sektor Hospitality
q SMK Pusat Keunggulan
q Sekolah Pencetak Wirausaha

KEUNGGULAN SEKOLAH
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PENTINGNYA ANALISIS SWOT 



ANALISIS SWOT
Strengths ( Kekuatan )

1. Memiliki Peralatan dan Sarana Prasarana 
yang memadai

2. Memiliki Sumber Daya Manusia (SDM) 
yang handal

3. Menyelenggarakan pembelajaran berbasis 
Teaching Factory

4. Adanya kurikulum Merdeka 
Weaknesses( kelemahan )

1. Belum adanya payung hukum untuk 
pengelolaan keuangan dari hasil 
Teaching Factory

2. Perekonomian orang tua /wali murid yang 
dalam kategori menengah ke bawah

3. Pembelajaran yang membosankan



ANALISIS SWOTOpportunities ( Peluang )
1. Institusi Pasangan yang mempunyai kepedulian untuk mengembangkan Teaching 

Factory di sekolah dengan adanya Instruksi Presiden Nomor 9 tahun 2016 tentang 
Revitalisasi SMK

2. Kebijakan Pemerintah Provinsi Jawa Timur tentang Badan Layanan Umum Daerah 
(BLUD) bagi Sekolah yang memiliki unit usaha dapat mengajukan menjadi sekolah 
yang melaksanakan  Pola Pengelolaaan Keuangan (PPK) BLUD.

Threats ( Ancaman )

1. Pantauan dari masyarakat tentang hasil dana penyelenggaraan Teaching Factory  
yang membuat tidak nyaman untuk mengembangkan Teaching Factory.

2. Regulasi dari Pemerintah Provinsi Jawa Timur dengan tidak diperkenannya 
penarikan SPP, berdampak orang tua wali murid yang memiliki asumsi Pendidikan 
gratis sehingga sulit untuk diharapkan adanya Sumbangan dari Orang tua /wali 
murid untuk mempertahankan penyelenggaraan Pendidikan yang berkualitas.



5 (LIMA) KOMPETENSI KEPALA SEKOLAH 
MENURUT PERMENDIKBUD NOMOR 13 TAHUN 

2007

1. KOMPETENSI KEPRIBADIAN
2. KOMPETENSI MANAJERIAL
3. KOMPETENSI KEWIRAUSAHAAN
4. KOMPETENSI SUPERVISI 
5. KOMPETENSI SOSIAL
Mengembangkan Pembelajaran berbasis project riil dalam 
Implementasi Kurikulum Merdeka melalui Teaching Factory pada 
semua program  keahlian yang ada



KOMPETENSI KEWIRAUSAHAAN

• Menciptakan inovasi yang berguna bagi pengembangan sekolah
• Bekerja keras untuk mencapai keberhasilan
• Memiliki motivasi yang kuat untuk sukses dalam melaksanakan 

tupoksinya sebagai pimpinan sekolah
• Pantang menyerah dan selalu mencari solusi terbaik dalam 

menghadapi kendala yang dihadapi sekolah
• Memiliki naluri kewirausahaan dalam mengelola kegiatan 

produksi/jasa sebagai sumber belajar peserta didik 



KURIKULUM MERDEKA



BANTUAN PEMERINTAH PROVINSI 
JAWA TIMUR

Ø Gubernur Jawa Timur mencanangkan Program 
TISTAS 
    (Pendidikan Gratis Berkualitas)

Ø Program TISTAS dengan diberikan bantuan 
operasional 
    berupa Bantuan Penunjang Operasional
Penyelenggaraan
    Pendidikan (BPOPP) 
Ø Kepala sekolah harus mendukung dan 

mengupayakan Program TISTAS .



DEMO MENOLAK SUMBANGAN

•



KESIMPULAN SWOT

Content  Here

Dari analisis SWOT ini 
maka disimpulkan

bahwa
 memaksimalkan 

Teaching Factory 
dan Pemanfaatan 

Asset sekolah dapat 
dilaksanakan untuk 

mendapatkan sumber 
pendanaan baru bagi 

sekolah. 

Hasil pendapatan yang 
bersumber dari Teaching 
Factory dan Pemanfaatan 

Asset sekolah dikelola 
dengan 

Pola Pengelolaan 
Keuangan (PPK) BLUD.

SMKN 1 BUDURAN 
mengambil kebijakan 

untuk 
MENGEMBANGKAN 

TEACHING FACTORY
dengan menerapkan 

Pola Pengelolaan 
Keuangan (PPK) BLUD.
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SMKN 1 Buduran Sidoarjo 
ditetapkan sebagai sekolah 

yang menerapkan Pola 
Pengelolaan Keuangan BLUD 

(PPK- BLUD)  
oleh

Keputusan Gubernur JATIM 
No. 188/519/KPTS/013/2017

pada tanggal 19 September 
2017

Gubernur Jawa Timur
Dr. H. Soekarwo

Keputusan Gubernur JATIM 
No. 188/417/KPTS/013/20120
Tentang Penetapan SMKN pada 

Dinas Pendidikan Prov. Jatim Sbg 
BLUD

pada tanggal 10 September 2020
Gubernur Jawa Timur

KHOFIFAH INDAR PARAWANSA



ALTERNATIF SOLUSI
1. MENGEMBANGKAN 

TEACHING FACTORY
2. MERUBAH BAHAN PRAKTEK 

MENJADI PRODUK JADI YANG 
LAKU TERJUAL



Morph

Morph makes smooth animations and object movements in your 
presentation. You use two similar slides to perform the 
animation, but it looks to your audience like the action happens 
on one slide. 

Play the video on the right to see a quick example.

Morph is a subscription-only feature. If you have an Office 365 
subscription, you can try it yourself with the steps on the next 
slide.



Welcome to PowerPoint
5 tips for a simpler way to work



Designer helps you get your point across

PowerPoint Designer suggests professional designs for your 
presentation, based on the content in your slides. 

Designer is a subscription-only feature. If you have an Office 
365 subscription, the next slide shows you how it works in a 
new presentation.



How to use PowerPoint Designer

How it works:

1 Start a new presentation by going to File > New > Blank 
Presentation.

2 On the very first slide, add a picture: Go to Insert > Pictures or 
Insert > Online Pictures and choose the picture.

Hint: You need to be online when you add the picture.

3 When PowerPoint asks your permission to get design ideas, 
select Let's Go.

4 Choose a design you like from the Design Ideas task pane.



LATAR BELAKANG

 • Kekurang pahaman tentang Prinsip dasar teaching factory adalah 
pengintegrasian pengalaman dunia kerja ke dalam kurikulum sekolah.
 • Semua peralatan dan bahan serta pelaku pendidikan disusun dan dirancang 
untuk melakukan proses produksi dengan tujuan untuk menghasilkan produk 
(barang ataupun jasa)/ada dalam Modul Ajar
 • Teaching factory merupakan perpaduan dari pembelajaran berbasis produksi 
dan pembelajaran kompetensi.
 • Dalam pembelajaran berbasis produksi, siswa terlibat langsung dalam proses 
produksi, sehingga kompetensinya dibangun berdasar kebutuhan produksi. 



MELAKSANAKAN KEGIATAN PEMBELAJARAN 
 
Setidaknya dilakukan dengan 3 tahapan sebagai berikut 

a) Tahap pembelajaran kompetensi kerja

b) Tahap produksi 

c) Pengembangan wirausaha 



A) TAHAP PEMBELAJARAN KOMPETENSI KERJA 

Pada tahap ini peserta didik dilatih dan disiapkan untuk menguasai kompetensi kerja yang 
diperlukan dalam memproduksi produk yang akan dihasilkan. Langkah- langkah pembelajaran 
dapat dilakukan dengan mengamati dan menganalisis produk yang akan dibuat, merencanakan 
kebutuhan tempat, bahan dan alat, memproduksi contoh/sampel produk, mengevaluasi produk 
dan hasil kerja. Dalam proses ini guru melatih dan membimbing siswa untuk menguasai 
keterampilan yang diperlukan dalam menghasilkan produk sesuai dengan standar yang 
ditetapkan dan siswa berlatih dengan mengerjakan produksi sampel produk. 
 



B) TAHAP PRODUKSI 

Pada tahap produksi siswa dapat dibagi/dikelompokkan sesuai deskripsi pekerjaan yang 
harus dilakukan dan bekerja secara tim untuk melakukan produksi dengan langkah sebagai 
berikut, Siswa memahami spesifikasi produk yang akan dikerjakan meliputi desain, standar 
ukuran, standar kualitas, jumlah, waktu, siswa bekerja secara mandiri atau berkelompok 
memproduksi produk sesuai target dan standar kualitas produksi yang telah ditetapkan, 
menerapkan budaya K3, guru melakukan pengendalian mutu selama proses produksi, dan 
guru dan siswa bersama melakukan evaluasi akhir terhadap produk yang telah dihasilkan 





PENGEMBANGAN WIRAUSAHA 

Pembelajaran TEFA diharapkan juga menumbuhkan keterampilan berwirausaha maka dalam 
tahap ini siswa dapat dilatih dan diajar 
1) Berkreasi untuk mengembangkan dan melakukan inovasi produk 
2) Mengembangkan kegiatan pemasaran secara luar jaringan (offline) dan dalam jaringan 
(online) 
3) Mengembangkan komunikasi dan layanan prima kepada pelanggan 
4) Membuat rancangan pengembangan bisnis dengan Kanvas model bisnis 
5) Evaluasi akhir.  





Setting up Morph

Try it yourself with these two simple “planets”:

1 Duplicate this slide: Right-click the 
slide thumbnail and select 
Duplicate Slide.

2 In the second of these two identical 
slides, change the shapes on the 
right in some way (move, resize, 
change color), then go to 
Transitions > Morph.

3 Return to the first of the two slides 
and press Slide Show button and then 
select Play to see your circle morph!

Hint: Effect Options gives you even more 
options for Morph.



Working together in real time

When you share your presentation with others, you’ll see them 
working with you at the same time. 

How it works:

1 Select Share from above the ribbon, 
or by using short-key Alt-ZS, to invite 
people to work with you (You can 
save to the cloud at this point.)

2 When other people are in the presentation, 
a marker shows who is on which slide…

3 …and the part of the slide they're 
editing.



You’re an expert with Tell Me
The Tell Me box finds the right command when you need it, 
so you can save time and focus on your work.

Try it:

1 Select the Robot picture on the right.

SELECT ME

2 Type animation in the Tell Me box, and then 
choose Add Animation.

3 Choose an animation effect, 
like Zoom, and watch 
what happens.



Explore without leaving your slides
Smart Lookup brings research directly in to PowerPoint.

Try it:

1 Right-click in the word office in the 
following phrase: office furniture

2 Choose Smart Lookup, and notice that 
results are contextual for that phrase, not 
Microsoft Office apps.

3 Just for fun, try Smart Lookup again by 
right-clicking in the word Office in Step 2.





More questions about PowerPoint?

Select the Tell Me                   button and type what you want to know.

Visit the PowerPoint team blog

Go to free PowerPoint training

Give feedback about this tour

SELECT THE ARROW WHEN IN SLIDE SHOW MODE

http://go.microsoft.com/fwlink/?LinkId=617172
http://go.microsoft.com/fwlink/?LinkId=623327
https://go.microsoft.com/fwlink/?linkid=854609


MAN POWERING

1. GURU     : SEBAGAI GM & DEPT HEAD
2. ALUMNI : SUPERVISOR
3. SISWA KELAS XII : LEADER, SUPERVISOR, PELAKSANA
4. SISWA KELAS XI : PELAKSANA 
5. SISWA KELAS X : OJT
6. TIM KRAETIF (GURU DAN SISWA) SEBAGAI 

MARKETING 









MELIBATKAN DAN MENGEMBANGKAN KERJASAMA 
DENGAN INDUSTRI MITRA 

Pengembangan kerjasama sangat diperlukan dalam pelaksanaan TEFA. Bentuk kerjasama 
TEFA diantara nya dapat berupa 
1. dukungan sumberdaya,
2.  budaya industri, 
3. pengembangan perangkat pembelajaran, 
4. magang,
5.  pengaturan tata letak, pengembangan 
6.  pemasaran produk
7. uji kompetensi
8.  guru tamu dan lainnya. 



PENATAAN BENGKEL DAN PERALATAN 
Untuk melakukan pembenahan bengkel perlu dilakukan Analisis pekerjaan dan alur produksi 
terkait bahan, alat, waktu, dan layout mesin. Dalam penataan laboratorium dan bengkel juga 
memperhatikan lingkungan kerja yang aman, nyaman dan sehat dengan penerapan budaya 5R. 





PENERAPAN BUDAYA INDUSTRI
DI EDOTEL TEMATIK

� PRE OPENING

� COMMISSIONING TEST (AIR, LISTRIK PADA 
BEBAN PUNCAK)

� BEROPERASIONAL 24 JAM
� DUTY MANAJER 

� PELAKSANAAN MORNING BRIEFING

� PENYUSUNAN RENCANA SRATEGI BISNIS
� BUDGETING  TAHUNAN



PELAKSANAAN MORNING BRIEFING
Dilaksanakannya Briefing Pada Setiap Peralihan Shift 
Kerja Dan Orning Brifing Oleh Tim Manajemen Edotel



PELIBATAN GURU DAN SISWA DALAM 
PENERAPAN BUDAYA INDUSTRI

Telibatnya guru dan siswa dalam menciptakan budaya industri yang 
diwujudkan dalam pelaksanaan operasional edOTEL yang melibatkan 
guru dan siswa serta tenaga profesional



CONTOH IMPLEMENTASI TENAGA KERJA



Sistem blok

• Kurikulum tematik











SEBELUM KERJA SAMA DENGAN DUDIKA SESUDAH KERJASAMA DENGAN DUDIKA

RENOVASI KAMAR SUITE ROOM



SEBELUM KERJA SAMA DENGAN DUDIKA SESUDAH KERJA SAMA DENGAN DUDIKA

LIVING ROOM & DINING ROOM



SEBELUM KERJA SAMA DENGAN DUDIKA SESUDAH KERJA SAMA DENGAN DUDIKA

HASIL PEKERJAAN DI DELUXE ROOM 
DOUBLE BED



SEBELUM KERJA SAMA DENGAN DUDIKA SESUDAH KERJASAMA DENGAN DUDIKA

HASIL PEKERJAAN DELUXE ROOM
TWINE BED



SEBELUM KERJA SAMA DENGAN DUDIKA SESUDAH KERJA SAMA DENGAN DUDIKA

HASIL PEKERJAAN BATH ROOM



SEBELUM KERJASAMA DENGAN DUDIKA SESUDAH KERJASAMA DENGAN DUDIKA

HASIL PEKERJAAN SUPERIOR ROOM



                                   TAMPILAN PUBLIC AREA 
EDOTEL



KAMAR DENGAN TEMA TATA 
BUSANA



    
KAMAR DENGAN TEMATIK 

KECANTIKAN



KAMAR TEMATIK KECANTIKAN



KAMAR DENGAN TEMATIK BOGA



SEBELUM KERJASAMA DENGAN DUDIKA SESUDAH KERJASAMA DENGAN DUDIKA

HASIL PEKERJAAN MEETING ROOM



RENOVASI TERAS LOBBY

Pekerjaan Renovasi  Pada 

Bagian Ini, Meliputi :

v Renovasi Joglo

v Pembuatan Papan 

Nama

vTambahan Ornamen 

Exterior

SEBELUM SESUDAH



1. MESIN CUCI
2. MESIN PENGERING
3. SETRIKA UAP
4. PABX
5. DROB BOX 
6. WET AND DRY VACUM CLEANER
7. PMS (Property Management System )

PERALATAN PRAKTEK SISWA



1. SAFE DEPOSIT BOX
2. MINI BAR
3. KUNCI  VING CARD
4. SPRING BED STANDART 

HOTEL BERBINTANG
5. TELEVISI  43”
6. TELEVISI  50 “

PERALATAN KELENGKAPAN 
FASILITAS EDOTEL



PENGGUNAAN SYSTEM KEAMANAN 
KUNCI KAMAR DENGAN “VING CARD” 





PENGADAAN GENERAL STORE 
UNTUK DISTRIBUSI BAHAN DAN ALAT

Disediakannya general store sebagai sarana 
distribusi bahan dan alat sesuai standart industri





















INOVASI PRODUK DENGAN KAMAR TEMATIK ULP



EDOTEL  TEMATIK SMKN 1 BUDURAN DIKELOLA DENGAN MENERAPKAN  MANAJEMEN 
PROFESIONAL BERSTANDAR IDUKA 

DENGAN MOTO
“EDOTEL WITH FIVE STAR HOTEL SERVICE”



TAMPILAN TEMATIK TATA BOGA



















STRATEGY PEMASARAN
� PEMBENTUKAN TIM KREATIF UNTUK 

MENGELOLA MEDIA DIGITAL
� TIM SALES CALL UNTUK MEMBINA 

HUBUNGAN DENGAN INSTANSI, 
PERUSAHAAN, IO, DLL.

� PENERAPAN DINAMIC PRICING
� BEKERJA SAMA DENGAN OTA/MARKET 

PLACE



PAMERAN UMKM





DIALOG DENGAN LEMBAGA TERKAIT
(TGL 9 NOPEMBER 2023)



DIALOG DENGAN DINAS KOPERASI DAN USAHA MIKRO 
KABUPATEN SIDOARJO TANGGAL 8 NOPEMBER 2023



Tanggal 15 Nopember 2023

DIALOG DENGAN DINAS 
TENAGA KERJA DAN 

DINAS KOPERSI USAHA 
MIKRO DAN 

KOMITE SEKOLAH 





PEMBELAJARAN BERBASIS PROJECT





PEMBELAJARAN BERBASIS INDUSTRI / 
TEACHING FACTORY



q Produk 
.Titik Satu Kopi

Mampu menjadi 
Tranding Topik di 
kuliner Sidoarjo 
mengalahkan 
produk ternama 
lainnya  sebagi 
bukti produk SMK 
mampu bersaing



SISTEM BLOK  DALAM TEACHING FACTORY

• PEMBELAJARAN KOLABORASI ANTAR MAPEL







KERJASAMA DENGAN LIPPOPLAZA SIDOARJO DAN 
UMKM



TAMPIL DI AJANG JMFW BERSAMA KEMENDIKBUD



TAMPIL DI AJANG JMFW BERSAMA KEMENDIKBUD



EVENT NASIONAL



MEMPROMOSIKAN PRODUK SEBELUM 
PELAKSANAAN PRAKTIK PRODUK YANG 

AKAN DIBUAT
Dengan membuat flyer untuk promosi melalui pelajaran Teknologi 

Informasi

















ASOSIASI WIRAUSAHA/UMKM 



MEMBERIKAN REWARD BAGI PESERTA 
DIDIK YANG MAMPU MEMPEROLEH 
OMZET TERBESAR :



HAL POSITIF

• PESERTA DIDIK TIDAK HANYA DIAJARI MEMBUAT PRODUK BAIK 
BARANG/JASA
• PESERTA DIDIK MENDAPATKAN ILMU SECARA KOMPERHENSIF MULAI DARI 

MERENCANAKAN PRODUK, MENGHITUNG HARGA POKOK DAN HARGA 
JUAL,MEMPROMOSIKAN MELALUI MEDIA SOSIAL ,MEMBUAT FLYER YANG 
MENARIK,SAMPAI DENGAN KOMUNIKASI DENGAN KONSUMEN 
/PELAYANAN KONSUMEN
• TEFA BENAR-BENAR MAMPU MENJADI TEMPAT MENGASAH 

PENGETAHUAN, KETRAMPILAN DAN ATTITUDE SERTA MELATIH BUDAYA 
KERJA/BUDAYA INDUSTRI
• MENDAPATKAN FINANSIAL YANG MAMPU MEMBANTU OPERASIONAL 

SEKOLAH MENUJU SEKOLAH MANDIRI
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TERIMA KASIH
Competent and Excellent



SDM Unggul :
Kompetensi ??
Karakter ??



 PEMERINTAH PROVINSI BENGKULU 

DINAS PENDIDIKAN DAN KEBUDAYAAN 
SMK NEGERI 2 BENGKULU TENGAH 

Alamat: Desa Srikaton Pondok Kelapa Kabupaten Bengkulu Tengah Telp. (0736) 5612747 
Email: smkndua_benteng@yahoo.com Kode Pos 38371 

 

Bengkulu, 26 November 2024 

Nomor : 430/632/SMKN2/XI/2024 

Lampiran : - 

Perihal : Permohonan Narasumber Pendampingan SMK 

PK 

Yth. 

Kepala LPPM 

Universitas Ahmad Dahlan (UAD) 

Di Tempat 

 

Dengan Hormat, 

Sehubungan akan diselenggarakannya Pendampingan SMK Pusat Keunggulan Tahun 2024 

maka dengan ini kami bermaksud memohon kepada Kepala LPPM UAD untuk bersedia 

mengijinkan nama-nama sebagai berikut: 

No Nama Jabatan Prodi Peran 

1 
Rendra Ananta Prima 

Hardiyanta, M.Pd. 

Dosen 

Fakultas 

Keguruan 

dan Ilmu 

Pendidikan 

Pendidikan Vokasional 

Teknologi Otomotif 

Narasumber 

2 
Pramudita Budiastuti, 

S.Pd., M.Pd. 

Pendidikan Vokasional 

Teknik Elektronika 

Menjadi Narasumber dalam Pendampingan SMK Pusat Keunggulan Tahun 2024 yang akan 

diselenggarakan pada: 

Hari/Tanggal : Kamis-Jumat, 28-29 November 2024 

Waktu : 09.00-Selesai 

Tempat : SMK Negeri 2 Bengkulu Tengah (Jl. Sri Katon Blok V, Seikaton, Kec. 

Pondok Kelapa, Kab. Bengkulu Tengan Prov. Bengkulu) 

Demikian surat undangan ini kami buat. Besar harapan kami atas kesediaannya untuk 

membantu kegiatan kami. Atas perhatiannya kami ucapkan Teima Kasih. 

 

 

 

 

 

 

 

 

 

 

Tembusan Yth. 

1. Dekan Fakultas Keguruan dan Ilmu Pendidikan 

2. Kaprodi PVTO 

3. Kaprodi PVTE 

mailto:smkndua_benteng@yahoo.com


 PEMERINTAH PROVINSI BENGKULU 

DINAS PENDIDIKAN DAN KEBUDAYAAN 
SMK NEGERI 2 BENGKULU TENGAH 

Alamat: Desa Srikaton Pondok Kelapa Kabupaten Bengkulu Tengah Telp. (0736) 5612747 
Email: smkndua_benteng@yahoo.com Kode Pos 38371 

Bengkulu, 29 November 2024 

Nomor : 430/633/SMKN2/XI/2024 

Lampiran : - 

Perihal : Ucapan Terima Kasih 

 

Yth. 

Kepala LPPM 

Universitas Ahmad Dahlan (UAD) 

Di Tempat 

 

Dengan Hormat, 

Sehubungan telah diselenggarakannya Pendampingan SMK Pusat Keunggulan Tahun 2024 

maka dengan ini kami mengucapkan terima kasih kepada Kepala LPPM UAD telah bersedia 

mengijinkan nama-nama sebagai berikut: 

No Nama Jabatan Prodi Peran 

1 
Rendra Ananta Prima 

Hardiyanta, M.Pd. 

Dosen 

Fakultas 

Keguruan dan 

Ilmu 

Pendidikan 

Pendidikan Vokasional 

Teknologi Otomotif 

Narasumber 

2 
Pramudita Budiastuti, 

S.Pd., M.Pd. 

Pendidikan Vokasional 

Teknik Elektronika 

sebagai Narasumber dalam Pendampingan SMK Pusat Keunggulan Tahun 2024 yang telah 

diselenggarakan pada: 

Hari/Tanggal : Kamis-Jumat, 28-29 November 2024 

Waktu : 09.00-Selesai 

Tempat : SMK Negeri 2 Bengkulu Tengah (Jl. Sri Katon Blok V, Seikaton, Kec. 

Pondok Kelapa, Kab. Bengkulu Tengan Prov. Bengkulu) 

Demikian surat ini kami buat. Atas perhatiannya kami ucapkan terima kasih. 

 

 

 

 
 
 
 
 
 
 

Tembusan Yth. 

1. Dekan Fakultas Keguruan dan Ilmu Pendidikan 

2. Kaprodi PVTO 

3. Kaprodi PVTE 
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